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Preface
For details, see the following topics:

•

Progress Corticon documentation

•

Overview of Progress Corticon

Progress Corticon documentation
The following documentation, as well as a What's New in Corticon document, is included with this
Progress Corticon release:
Corticon Tutorials
Corticon Studio Tutorial: Basic Rule
Modeling

Introduces modeling, analyzing, and testing rules and
decisions in Corticon Studio. Recommended for
evaluators and users getting started. See also the
PowerPoint-as-PDF version of this document that is
accessed from the Studio's Help menu.

Corticon Studio Tutorial: Advanced Rule Provides a deeper look into Corticon Studio's capabilities
Modeling
by defining and testing vocabularies, scope, collections,
messages, filters, conditions, transient data, and
calculations in multiple rulesheets that are assembled
into a Ruleflow. See also the PowerPoint-as-PDF version
of this document that is accessed from the Studio's Help
menu.

Progress Corticon: Installation Guide: Version 5.4.1

7

Preface

Corticon Tutorial: Using Enterprise Data Introduces Corticon's direct database access with a
Connector (EDC)
detailed walkthrough from development in Studio to
deployment on Server. Uses Microsoft SQL Server to
demonstrate database read-only and read-update
functions.
Corticon Studio Documentation: Defining and Modeling Business Rules
Corticon Studio: Installation Guide

Step-by-step procedures for installing Corticon Studio
on computers running Microsoft Windows as a
standalone installation and as a part of an existing
Eclipse installation such as Progress Developer Studio
for OpenEdge. Shows how to enable internationalization
on Windows.

Corticon Studio: Rule Modeling Guide Presents the concepts and purposes the Corticon
Vocabulary, then shows how to work with it in Rulesheets
by using scope, filters, conditions, collections, and
calculations. Discusses chaining, looping, dependencies,
filters and preconditions in rules. Presents the Enterprise
Data Connector from a rules viewpoint, and then shows
how database queries work. Provides information on
versioning, natural language, reporting, and localizing.
Provides troubleshooting and many Test Yourself
exercises.
Corticon Studio: Quick Reference Guide Reference guide to the Corticon Studio user interface
and its mechanics, including descriptions of all menu
options, buttons, and actions.
Corticon Studio: Rule Language Guide Reference information for all operators available in the
Corticon Studio Vocabulary. A Rulesheet example is
provided for many of the operators. Includes special
syntax issues, handling arithmetic and character
precedence issues.
Corticon Studio: Extensions Guide

Detailed technical information about the Corticon
extension framework for extended operators and service
call-outs. Describes several types of operator extensions,
and how to create a custom extension plug-in.

Corticon Server Documentation: Deploying Rules as Decision Services
Corticon Server: Integration &
Deployment Guide
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An in-depth, technical description of Corticon Server
deployment methods, including preparation and
deployment of Decision Services and Service Contracts
through the Deployment Console tool. Describes JSON
request syntax and REST calls. Discusses relational
database concepts and implementation of the Enterprise
Data Connector. Goes deep into the server to discuss
state, persistence, and invocations by version or effective
date. Includes server monitoring techniques, performance
diagnostics, and recommendations for performance
tuning.
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Corticon Server: Deploying Web
Services with Java

Details installing the Corticon Server as a Web Services
Server, and then deploying and exposing Decision
Services as Web Services on the Pacific Application
Server (PAS) and other Java-based servers. Includes
samples of XML and JSON requests. Presents the
features and functions of the browser-based Server
Console. Provides administrative instructions for the
Pacific Application Server.

Corticon Server: Deploying Web
Services with .NET

Details installing the Corticon Server as a Web Services
Server, and then deploying and exposing decisions as
Web Services with .NET. Includes samples of XML and
JSON requests. Provides installation and configuration
information for the .NET Framework and Internet
Information Services (IIS) on various supported Windows
platforms.

Overview of Progress Corticon
Progress® Corticon® is the Business Rules Management System with the patented "no-coding"
rules engine that automates sophisticated decision processes.

Progress Corticon products
Progress Corticon distinguishes its development toolsets from its server deployment environments.

• Corticon Studio is the Windows-based development environment for creating and testing
business rules:

• When installed as a standalone application, Corticon Studio provides the complete Eclipse
development environment for Corticon as the Corticon Designer perspective. You can use
this fresh Eclipse installation as the basis for adding other Eclipse toolsets.

• When installed into an existing Eclipse such as the Progress Developer Studio (PDS), our
industry-standard Eclipse and Java development environment, the PDS enables development
of Corticon applications in the Corticon Designer perspective that integrate with other
products, such as Progress OpenEdge.
Note: Corticon installers are available for 64-bit and 32-bit platforms. Typically, you use the
64-bit installer on a 64-bit machine, where that installer is not valid on a 32-bit machine. When
adding Corticon to an existing Eclipse, the target Eclipse must be an installation of the same
bit width. Refer to the Corticon Studio: Installation Guide to access, prepare, and install Corticon
Studio.
Studio Licensing - Corticon embeds a time-delimited evaluation license that enables
development of both rule modeling and Enterprise Data Connector (EDC) projects, as well as
testing of the projects in an embedded Axis test server. You must obtain Studio development
licenses from your Progress representative.

• Corticon Servers implement web services for business rules defined in Corticon Studios:
• Corticon Server for deploying web services with Java is supported on various application
servers, and client web browsers. After installation on a supported Windows platform, that

Progress Corticon: Installation Guide: Version 5.4.1

9

Preface

server installation's deployment artifacts can be redeployed on various UNIX and Linux web
service platforms as Corticon Decision Services. The guide Corticon Server: Deploying web
services with Java provides details on the full set of platforms and web service software that
it supports, as well as installation instructions in a tutorial format for typical usage.

• Corticon Server for deploying web services with .NET facilitates deployment of Corticon
Decision Services on Windows .NET Framework and Microsoft Internet Information Services
(IIS). The guide Corticon Server: Deploying web services with .NET provides details on the
platforms and web service software that it supports, as well as installation instructions in a
tutorial format for typical usage.
Server Licensing - Corticon embeds a time-delimited evaluation license that enables evaluation
and testing of rule modeling projects on supported platform configurations. You must obtain
server deployment licenses and server licenses that enable the Enterprise Data Connector
(EDC) from your Progress representative.
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Overview of Corticon Studio installations and
upgrades
Techniques for installing Corticon Studio
There are two techniques for installing Corticon Studio:

• Downloading and running the Corticon Studio installers and updaters on page 13, the typical
use, which enables a complete Corticon Studio Eclipse installation that can standalone, or be
tailored into another Eclipse IDE on the same machine, such as Progress Developer Studio for
OpenEdge.

• Installing Corticon plugins into an existing Eclipse on page 23 which enables scripted copying
and tailoring of Corticon Studio plugins into an existing Eclipse.

What Corticon Studio installers provide
Corticon Studio 5.4 installers are available in packages for 64-bit and 32-bit platforms. Refer to
your target machine's Control Panel > System page to choose the appropriate package. While
you could install the 32-bit version on a 64-bit machine, it is not recommended.
Both installer packages include:

• Corticon Studio resources
• Corticon Studio online documentation
• Eclipse Development Environment and Eclipse online documentation.
• Java Runtime Environment (JRE)
• Sample projects
• Tutorials
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• JavaDoc
• Corticon Server WAR file at Server\axis.war file, specifically for use in development of
Progress OpenEdge Business Rules.

Supported platforms for Corticon Studio installations
For new installations, confirm that your target platform is supported. Connect to the Progress
Software web page Progress Corticon 5.4 - Supported Platforms Matrix for more information to
review the currently supported Corticon Studio operating systems, Eclipse versions, and EDC
database brands.

Installation options
A new Corticon Studio install lets you choose to install it standalone, or to add its resources to
either Progress Developer Studio for Open Edge 11.4 or another existing Eclipse 4.3 installation.
Once you have chosen the preferred installation, the service pack will apply its update to that
installation.

12
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Downloading and running the Corticon
Studio installers and updaters
Downloading the Corticon Studio installer packages
Corticon Studio 5.4.0 products and their respective Service Packs are packaged in executable
installer applications:

• The 5.4.0 installer:
• For supported 64-bit Windows machines:
PROGRESS_CORTICON_5.4_STUDIO_WIN_64.exe.

• For supported 32-bit Windows machines:
PROGRESS_CORTICON_5.4_STUDIO_WIN_32.exe.
Note: If you choose to install the 32-bit product on a 64-bit machine, the installation directory
defaults to C:\Program Files (x86)\Progress where (x86) distinguishes 32-bit
applications.The documentation will refer to C:\Program Files\Progress as the installation
path so you must be aware of the variation.

• The corresponding 5.4.1 Service Pack installer to update an existing 5.4.0 installation:
• For supported 64-bit Windows machines:
PROGRESS_CORTICON_5.4.1_STUDIO_WIN_64.exe.

• For supported 32-bit Windows machines:
PROGRESS_CORTICON_5.4.1_STUDIO_WIN_32.exe.
To download the required installer:
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1. Get credentials to access and download packages on the Progress Software Electronic Software
Download (ESD) site.
2. Connect to the ESD, and then navigate to the Corticon 5.4 pages.
3. Locate, download, and save the required installers to a temporary location accessible by the
target machine.
You can install Corticon Studio 5.4 on a machine that does not already have it installed. If you are
upgrading from 5.3, you can install 5.4 as a separate installed software on the same machine. You
must manage any port overloads that might result from running both versions.
Note: An installed version of Corticon Server .NET 5.2 or earlier on the target machine must be
uninstalled, then Corticon Server .NET 5.4 installed, followed by applying the 5.4.1 Service Pack.
Consult with Progress Corticon Support or your Progress representative to consider your migration
strategies for existing assets before you take action.

Installation type
There are three types of Corticon Studio installations:

• New 5.4.1 installation - Perform a new installation, then update it with the corresponding 5.4.1
Service Pack.

• Update a 5.4.0 installation with the latest Service Pack - Apply the 5.4.1 Service Pack.
• Upgrade a 5.3 or earlier installation to the latest 5.4 Service Pack - An installed version of
Corticon Studio 5.2 or earlier installed on the target machine must be uninstalled, then the
preferred Corticon 5.4.0 Studio installed, followed by applying its appropriate 5.4.1 Service
Pack.
Consult with Progress Corticon Support or your Progress representative to consider your
migration strategies for existing assets before you take action.

Installation technique
The downloaded installer launches an interactive user interface that steps through the process.
See the next topic, Performing a new installation using the Installer Wizard, for details. If you prefer
an unattended installation, review the choices in the installer GUI panels, and then see the topic
Performing Silent Installations for detailed instructions on creating and using response files to
perform silent installations.

Before running installers
To avoid possible constraints on the installer, do the following:

• Confirm that you have Administrator permissions on the workstation - Administrator rights
allow the installer to copy all the Corticon Studio files to their proper locations. You must have
Administrator rights and permissions to install this software. See your system administrator to
obtain these rights.

• Obtain system access - Several Corticon Studio features write files to the “home” directory
structure. If the target machine for the Corticon Studio installation does not have read and write
access to this directory, you will need to choose a directory location where the Corticon Studio
user will have both read and write access.

• Disable anti-virus, anti-malware, and anti-spyware protection applications - Before
performing the installation, we highly recommend temporarily disabling any anti-virus and
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anti-spyware software that may be running on your machine. This software often prevents or
interferes with correct installation.
For details, see the following topics:

•

Performing a new installation using the Installer Wizard

•

Applying a Service Pack update

•

Performing Silent Installations

•

Uninstalling Corticon Studio installed from downloaded installers

Performing a new installation using the Installer
Wizard
To perform a new installation of Corticon Studio 5.4.0:
1. Double click on the appropriate installer file, PROGRESS_CORTICON_5.4_STUDIO_WIN_64.exe
or PROGRESS_CORTICON_5.4_STUDIO_WIN_32.exe, to launch the Corticon Studio installer.
The installer opens in the installer wizard.
2. The first installer panel opens with information about the installer.

3. Click Next to continue.
The License Agreement panel opens.
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This screen displays the Progress Software End User License Agreement (EULA). Use the
scroll bar at the right of the screen to read the agreement content.
4. When you understand and agree to the terms, choose I accept the terms in the license
agreement, and then click Next to continue.
The Choose Install Folder panel opens.
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5. Note: If you choose to install the 32-bit product on a 64-bit machine, the installation directory
defaults to C:\Program Files (x86)\Progress where (x86) distinguishes 32-bit
applications.The documentation will refer to C:\Program Files\Progress as the installation
path so you must be aware of the variation.
Specify the installation location. The default location for the installation directory and the work
directory are as shown above. (For the work directory, the default subdirectory under Users
is the current username.) Either accept the default locations, or specify each preferred (and
different) location.
When you have the locations specified, click Next to continue.
6. The installer attempts to discover an existing Progress Developer Studio for OpenEdge (PDS-OE)
on the machine. If the Eclipse/OpenEdge version are compatible, and if the installer is the
corresponding bit width, the following panel opens:

If this panel is displayed, choose whether to install into that PDS-OE location to get the benefit
of a tailored installation, and then click Next to continue.
7. If you had no PDS-OE installation, or passed on installing into a discovered PDS-OE, the
External eclipse configuration panel opens:
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• If you select Yes on this panel, the entry area for the External Eclipse location where you
want to plug in the Corticon Studio is presented:

Enter or browse to the location of the Eclipse target that is the same bit width as the installer
you are running.

• If you leave the selection as No, the required Java and Eclipse will be installed.
When you have decided which path to take, click Next to continue.
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8. The Pre-installation Summary panel opens.

Confirm that your installation location has adequate disk space for the Corticon Studio
components as well as 100 MB of workspace.
9. Click Install to continue.
An installation status window opens to display the state of the installation process. When the
process has finished, the Install Complete panel opens.
10. Click Done to quit and close the installer.
The installation of Corticon Studio is complete.

Applying a Service Pack update
To update a 5.4.0 installation of Corticon Studio to this Service Pack:
1. If the installed Corticon Studio you want to update is running, stop it now.
2. Double click on the appropriate update installer file,
PROGRESS_CORTICON_5.4.1_STUDIO_WIN-64.exe or
PROGRESS_CORTICON_5.4.1_STUDIO_WIN-32.exe, to launch the Corticon Studio updater.
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Note: IMPORTANT: Be sure that you are choosing the service pack installer with the bit width
corresponding to the underlying 5.4.0 installation you are upgrading. If you accepted default
install locations, the 64-bit Studio is placed at C:\Program Files\Progress while the 32-bit
Studio is placed at C:\Program Files (x86)\Progress. However if you specified a
preferred location, you can discover which bit width is in use by querying the Java version in
its jre\bin directory as shown for the following installation:
C:\_54x_install_dir\home\Studio\JRE\bin>java -version
java version "1.7.0_05"
Java(TM) SE Runtime Environment (build 1.7.0_05-b05)
Java HotSpot(TM) 64-Bit Server VM (build 23.1-b03, mixed mode)

which explicitly notes that it is 64-bit. Under 32-bit, there is no such indication, as shown:
C:\_54x_install_dir\home\Studio\JRE\bin>java -version
java version "1.7.0_05"
Java(TM) SE Runtime Environment (build 1.7.0_05-b05)
Java HotSpot(TM) Client VM (build 23.1-b03, mixed mode)

The installer prepares, and then opens the update wizard:

3. Click Next through the panels, and then click Install.
When the appropriate 5.4 installation is detected, and it is determined that this Service Pack has
not already been applied, the updater proceeds to complete the update of the installation.

Performing Silent Installations
Note: You can use corresponding procedures, as described in the 5.4.0 documentation, to capture
and run the underlying 5.4.0 Studio installation for this service pack.
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An unattended (silent) install requires that you first run an installation or updater in the installer
wizard to capture the selected options, and then use the captured response file on other targets
to 'playback' the responses into the installer without any user interaction.
Note: The bit width of the installer package and the target machine's bit width must correspond.
To perform silent installations for Corticon Studio:
1. Run the installer with your preferred locations and options to capture a response file, using the
syntax installer.exe -r file where installer is the preferred Studio installer, and
file is the response file you will reuse. For example,
PROGRESS_CORTICON_5.4.1_STUDIO_WIN_64.exe -r
C:\CorticonStudio64_541.responses
2. On other target machines, access the installer executable and the response file.
3. Run the installer using the syntax installer.exe -i silent -f file where installer
is the Studio installer, and file is your response file. For example,
PROGRESS_CORTICON_5.4.1_STUDIO_WIN_64.exe -i silent -f
C:\CorticonStudio64_541.responses.

Uninstalling Corticon Studio installed from
downloaded installers
To remove a version of Corticon Studio that was installed by the installer to prepare for a new
installation (or if you want to fully remove it), use this procedure. The major.minor product version
and all applied service packs are removed by the uninstaller.
To uninstall any version of Corticon Studio:
1. Backup any files you want to retain.
2. Navigate to [CORTICON_HOME]\Uninstall_Progress Corticon Studio 5.4.
3. Run Uninstall Progress Corticon Studio 5.4.exe.
The installed files are removed. Note that files you created are NOT removed or replaced during
this process.
If the Uninstaller program is unable to fully remove components (usually because they are open),
it will display messages, and might require a reboot to complete the process.
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Installing Corticon plugins into an existing
Eclipse
These instructions apply when you want to install Corticon functionality into an installed Eclipse
IDE. The technique uses a script to install plugins into an installed Eclipse 4.3 development
environment.
While product installer wizards require that you install 5.4.0 and then apply 5.4.1, this technique
does not require 5.4.0 to have been previously installed.
Note: IMPORTANT: Do not use this procedure if you installed Corticon 5.4.0 with the installer
wizard and are now updating it to the current service pack. Instead, use the service pack installer
wizard to apply the update.
1. A Java Software Development Kit (JDK) is required for Corticon, not just a Java Runtime
Environment (JRE). If you do not have one installed locally, download and install a 1.6 or higher
(1.7 preferred) version of the same bit-width as the existing Eclipse from the Oracle Java website
http://www.oracle.com/technetwork/java

Note: For the installation of the plugins, you can use the JRE that Eclipse is using. In Eclipse,
choose Window > Preferences, then select Java > Installed JREs.
2. Login to the Progress Software Electronic Software Download (ESD) site, and then navigate
to the Corticon 5.4 release. Download PROGRESS_CORTICON_5.4.1_STUDIO_PLUGINS.zip,
and then unpack into a clean temporary installation directory, such as C:\CorticonPlugins).
3. In a Command Prompt window at the temp location, check to see whether JAVA_HOME is set.
If not, set JAVA_HOME to the JDK root. For example: set JAVA_HOME=c:\jdk1.7u67_64
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4. If Eclipse is running, exit it.
5. In a Command Prompt in the script's location, run the script in the form:
integrateCorticon.bat –install

eclipse_target

where eclipse_target is the root directory of the existing Eclipse installation.
Eclipse installs its required plug-ins.
6. To ensure that Corticon Ruletests can locate javac to compile rules, add the path of the JDK
to your PATH as the default Java to use. For example:
set PATH=%JAVA_HOME%\bin;%PATH%

7. Specify the Corticon work directory, the folder where you want Corticon to write its log and other
temporary files. For example:
set CORTICON_WORK_DIR=c:\corticon_work_dir

8. When the script successfully completes, restart the Eclipse session, and then verify the
installation by selecting the menu command Help > About Eclipse. Click Installation Details
to confirm that Progress Corticon Feature is installed.
9. Open a project, and then run a Ruletest. A successful run indicates that the Java compiler is
being accessed correctly.
The integrateCorticon script enables other functions, such as uninstalling Corticon plugins.
For usage syntax, enter:
integrateCorticon.bat –help
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Upgrading projects coming forward from a
prior release
Every time you install a new release of Corticon Studio, many Corticon development assets
(Vocabularies, Rulesheets, Ruleflows, and Ruletests) might need to be upgraded for use in the
Corticon Studio. These could be projects you were working on or samples you imported from
another location. As you open each asset that needs to be upgraded, you are alerted as to the
required action, and encouraged to proceed to upgrade it. The asset upgrade process will force
the upgrade of dependent assets that also require a similar upgrade. This task can be tedious if
you have a lot of assets and a lot of projects.
The project upgrade utility lets you choose projects or folders of projects that will be upgraded all
in one pass. Typically, you would bring the projects into your workspace but you could choose to
point to folders that contain projects.
Performing this procedure just after upgrading your Corticon Studio will relieve you of having to
do this task as you work.
To upgrade a selected project:
1. After your Studio upgrade has succeeded, choose the Upgrade command,
, on the dropdown menu that opens when you right-click on any
project name on the Projects tab or the Rule Projects tab. The Upgrade Assets dialog box
opens, as shown:
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In this example, the LifeInsurance project was selected so all the assets in that project are
selected for upgrade.
2. Click Finish to start upgrade processing. You are alerted that this process cannot be undone,
so consider whether you should cancel, backup the files as-is, and then run the same upgrade
process again to completion.
3. After processing, the Update Results window opens, listing the assets that required upgrade
and were upgraded, as well as those that did not require an upgrade, as shown:
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You can choose to click Copy, and then paste the text into your preferred text editor.
4. Click OK to close the results window and the dialog box.
To upgrade one or more projects in one run:
1. Choose the Upgrade command,
, on the dropdown menu that opens
when you click Project on the Corticon menubar (or on the dropdown menu of a selected project
in the Project Explorer tabs) The Upgrade Corticon Assets dialog box opens.
2. Click Browse to navigate to the branch of tree that could contain several Rule Projects, and
click OK. The projects and their assets are listed in the Upgrade Assets dialog box, as in this
example:
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Note: For best performance, choose just several projects to upgrade in one run, and then
perform as many runs as needed.
3. Click Finish to start upgrade processing. You are alerted that this process cannot be undone,
so consider whether you should cancel, backup the files as-is, and then run the same upgrade
process again to completion.
4. After processing, the Update Results window opens, listing the assets that required upgrade
and were upgraded, as well as those that did not require an upgrade. You can choose to click
Copy and then paste the text into your preferred text editor.
5. Click OK to close the results window and the dialog box.
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Updating your Corticon license in Studio
Progress Corticon embeds an evaluation license in its products to help you get started.

• Corticon Studio evaluation licenses let you use database access (Enterprise Data Connector
or "EDC"), and are timed to expire on a preset date. While you typically do not need to acquire
a license for Studio during evaluation and early stage development, in the event that you are
alerted that your license is invalid or expired, contact your Progress Corticon representative to
obtain a workable license.

• Corticon Server evaluation licenses do not enable use of Enterprise Data Connector, and limit
the number of decision services, rules, and pools in use. They too are timed to expire on a
preset date. You will need to obtain a license that enables EDC on Corticon Server for that
section of the EDC tutorial.
This document focuses on the Corticon Studio procedures for updating a license. See the Corticon
Server and EDC tutorials for the procedures on their registration of the license for the Corticon
Server and its Deployment Console.
Note: When you are provided a license JAR, place on the target machine or at a location that is
network-accessible to the installation. The default license file for evaluation is embedded within
the installation and cannot be replaced directly. In this example, the license file, CcLicense.jar,
that both Studio and Server will use is placed at C:\licenses. You might prefer to place it in a
new folder, [CORTICON_HOME]\licenses.
To configure Corticon Studio for database access:
1. Select the menu command Window > Preferences.
2. Expand the Progress Corticon group.
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3. If you need to update the license or add your non-evaluation Studio license, enter its location
into the License File entry area, or browse to its location, as in this example where a licenses
folder was created at root:

4. Click Apply.
5. Expand the Progress Corticon group, and then click on Rule Modeling:
6. Choose the User Role option Integration and Deployment, as shown:

7. Click Apply, and then click OK.
8. Restart the Studio.
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When EDC is enabled, a Vocabulary in Corticon Studio displays its Database Access tab , as
shown:

Licensing of Corticon Server embedded in the Corticon Studio's OpenEdge
distribution
To facilitate the integration of OpenEdge with Corticon, Corticon Studio includes the WAR file to
enable running Corticon Server from the Studio. The embedded Studio license for Corticon Server
has the following constraints:

• Corticon Server requests must originate on the machine where the server is running -- in other
words, all on localhost. Requests from any other machine or host are not allowed.

• Corticon Server allows only one reactor for execution of one instance of a specified Decision
Service. As a developer, you can locally deploy many Decision Services simultaneously, and
you can use administrative functions, such as service availabilities. When you are ready for
production system testing, you must obtain a Corticon Server deployment license, and then
locate it in Corticon Server installations.
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6
Changing the Studio's memory allocation
To change the Corticon Studio memory allocation, edit the command file named eclipse.ini
in [CORTICON_HOME]\Studio\eclipse, and then change (typically, increase) the Xmx value
(maximum memory setting). The default Xmx setting is 350 megabytes, specified as Xmx350m.
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A
Enabling Studio internationalization
Localizing your rule modeling and processing environment involves three related functions:

• Displaying the Studio program in your locale of choice. This means switching the Corticon
Studio user interface (menus, operators, system messages, etc.) to a new language. This part
is described here.

• Displaying your Studio assets in your locale of choice. This means switching your Vocabularies,
Rulesheets, Ruleflows, and Ruletests to a new language. See "Localizing Corticon Studio" in
the Rule Modeling Guide.

• Requests submitted to a Corticon Server can specify an execution property that indicates the
locale of the incoming payload so that the server can transform the payload's decimal and
date values to the decimal delimiter and month literal names of the server, run the rules, and
return the output formatted to the submitter's preference. See "Handling requests and replies
across locales" in the Server Integration and Deployment Guide.

Displaying Studio in your locale of choice
When localized, Corticon Studio can:

• Display its full user interface in localized languages and fonts.
• Display all operators in the Operator Vocabulary in localized languages and fonts.
• Process XML messages (or Test inputs) containing data comprised of non-Latin characters
(for example, Japanese, Chinese or Korean).

• Post Rule Statements that contain non-Latin characters.
In order for Studio to display its user interface in your chosen locale, two requirements must be
satisfied:
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1. A language "bundle" or template must be created for your chosen language and installed in
CcI18nBundles.jar, both Studio and all deployed Server installations.
2. Your operating system must be running in your chosen locale when Studio starts up.

Creating a new language bundle
To create a new language bundle for Corticon Studio, you need to download the Localization
Toolkit for your version. Toolkits are available for all versions of Corticon Studio, and are normally
available from the Corticon Support Site. The Toolkit contains a ReadMe that describes how to
create a new bundle, save it, and install it.

Switching operating system locales
Before switching to a different locale, you may need to install necessary language support into the
Windows operating system and set the appropriate Regional Settings in the Regional and Language
Options.

Installing language support in Windows
You must add the preferred input languages into the Windows operating system. This procedure
follows the Windows 7 control panel interface. Other operating systems might vary.
1. From the Start menu, choose Control Panel.
2. In the Region and Language section, choose the Keyboards and Languages tab, and then
click Change keyboards.
3. Click Change Languages.
The Text Services and Input Languages dialog box opens:
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4. The installed languages are listed. Click Add to select preferred languages and their features.

Changing your machine's region
Next, you must change you regional settings so that your machine's locale specifies a non-English
language that you have installed. You must change it in both the Keyboards and Languages
specification and the Location specification.
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For example, to enable Japanese, choose the specifications shown below:

Testing the setup
Start Corticon Studio in the normal manner, and invoke the open dialog window by selecting menu
option File > Open.
If the installation was successful, buttons on the dialog (and other key static text labels) should be
presented in the selected region's language.
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